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Summary 
The purpose of this exercise was to assist the Central Department for the WTO at Egypt’s 
Ministry of Trade and Industry (CD/WTO) to clarify its negotiating objectives in regards to tariff-
rate quotas (TRQs) in the World Trade Organization’s Doha Round agriculture negotiations. At 
the outset of the assignment, our client emphasized that two outcomes were equally important: 
the findings from the analysis and the CD/WTO staff’s ability to produce similar analyses on 
their own in the future. With these objectives in mind, we developed an analytical method that 
was intended to be straightforward and easy to replicate. We prepared a step-by-step guide on 
how to conduct the analysis (attached as Appendix Three) that we presented to CD/WTO staff 
prior to our departure from Egypt. 

We present the full results of our analysis in the SUMMARY worksheet of the Microsoft Excel 
file that accompanies this Note (TRQ Analysis.xls). The analysis yielded the following key 
findings: 

• Egypt’s key agricultural exports are affected by only a few U.S. TRQs. Our analysis 
focused on 57 product groups (defined at the HS6 level) that account for the vast majority 
of Egypt’s agricultural exports. Appendix One lists these product groups. Only eight of 
these product groups are affected by U.S. TRQs:  

⎯ Cotton (520100) 

⎯ Peanuts (120210) 

⎯ Confectionary products (170490) 

⎯ Margarine (151790) 

⎯ Cheese (040690) 

⎯ Milk (040120) 

⎯ Food Preparations Not Elsewhere Specified (210690) 

⎯ Extracts (210120) 

• Long-staple cotton is the most important Egyptian agricultural export to the United 
States that is affected by U.S. TRQs. Long-staple cotton is Egypt’s most important 
agricultural export to the United States. It accounted for 38.1% of all Egyptian 
agricultural exports to the United States in 2002, and 98.7% of the value of exports 
affected by TRQs. Other Egyptian exports affected by U.S. TRQs include cheese, butter, 
and dried milk, but exports to the U.S. of these goods are dwarfed by cotton exports. 
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• U.S. TRQs for long-staple cotton are chronically underfilled. Egypt is a leading exporter 
of long-staple cotton to the United States, but the U.S. does not come close to filling its 
quotas for long-staple cotton. Underfill of the quota is due to one of two constraints (or 
some combination of them): either the in-quota tariff rates restrict demand for imports or 
the quotas’ administration methods are so complex that they act as non-tariff barriers. 
One must examine the in-quota tariffs and quota administration methods, as well as the 
U.S. market conditions for long-staple cotton, in greater detail in order to positively 
identify the cause of the underfill.  

• Egypt’s negotiating priorities in regards to U.S. should vary by quota. For Egypt to 
expand exports to U.S. under each quota, Egypt needs the U.S to relax each quota’s 
“binding instrument.” The “binding instrument” is the policy measure that determines the 
domestic price and volume of imports. When quotas are underfilled, the binding 
instrument is either the in-quota tariff rate or the quota administration method; when 
quotas fill and no out-of-quota imports occur, the binding instrument is the volume of the 
quota; and when quotas fill and out-of-quota imports occur, the binding instrument is the 
out-of-quota tariff. The binding instrument varies from quota to quota.  

 

We emphasize that Egyptian agricultural exports under U.S. TRQs are currently dominated 
by a single product – long-staple cotton – that is covered by two chronically underfilled 
TRQs. Before the CD/WTO makes other, non-cotton TRQs a negotiating priority, it may first 
wish to investigate why Egyptian exports under non-cotton TRQs are currently minimal or 
nil. Factors besides TRQs may constrain Egypt’s production of these products and/or foreign 
demand for them. 
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Analytical Framework and 
Methodology 
When negotiating TRQs, the essential question Egypt ought to consider is: which policy options 
will maximize Egypt’s welfare? The proper execution of such an analysis is a complex task. It 
requires construction of a model that defines various liberalization scenarios, then models effects 
on world prices under the different scenarios. Such a model would show changes in Egypt’s 
exports vis-à-vis other exporters. This type of analysis requires specialized analytical skills, 
massive amounts of data, and large investments of time.1 

The exercise performed here answer a narrower question: “which policy options are likely to 
increase a country’s imports from Egypt?” We assume a priori that increased exports are the 
preferred outcome.  

We do not consider price elasticities of supply and demand, for Egypt or for other exporters and 
importers.  In addition, we do not factor into our analysis the role of bilateral or other preferential 
TRQs – our focus is on multilateral TRQs only. These assumptions and omissions are limiting 
but useful: they permit a simplified analysis that yields important lessons, yet is feasible despite 
time, data and other constraints. 

We examined 57 commodities (identified at the six digit level) that account for the vast majority 
of Egypt’s agricultural exports. We call these products Egypt’s “key agricultural exports” (see 
Appendix One for the list of commodities).  

FINDING THE BINDING INSTRUMENT 
Our central analytical task was to identify the binding instrument for each U.S. TRQ that targets a 
key agricultural export of Egypt. The binding instrument is the policy measure that determines 
the domestic price and the volume of imports.2 We suggest that, in order to increase exports, 
                                                      

1 One example of such an analysis is OECD, Tariff-Rate Quotas and Tariffs in OECD Agricultural 
Markets: a Forward-looking Analysis. 2002.  

2 This definition and the scenarios that follows are based on OECD, Alternative Liberalisation Scenarios 
and Their Impacts on Quota Rents and Tariff Revenues in Selected OECD Agricultural Markets, 19 
November 2002, 8-10. COM/AGR/TD/WP(2002)23/FINAL.  
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Egypt’s negotiating priority should be to relax the binding instrument for each TRQ. The binding 
instrument varies in each of three possible scenarios: 

• Scenario 1: Imports are less than the quota volume (i.e. the quota is “underfilled”). In 
this case, the binding instrument is the in-quota tariff rate. Alternatively, the binding 
instrument could be complex or opaque quota administration methods that act as non-
tariff barriers. 

• Scenario 2: Imports equal, but do not exceed the quota volume (i.e., the quota is “filled” 
and there are no additional imports). In this case, imports are competitive on the 
domestic market at the in-quota tariff rate, but not at the out-of-quota rate. The quota 
volume is the binding instrument. 

• Scenario 3: Imports exceed the quota volume. In this case, the quota is filled, yet imports 
continue to enter at the out-of-quota tariff rate. Demand is sufficiently high that imports 
occur even after the addition of the out-of-quota tariff. The out-of-quota tariff rate 
conditions domestic demand: if it were lowered and all other conditions were held equal, 
domestic demand for the product would increase. In this case, the out-of-quota tariff 
rate is the binding instrument. 

METHODOLOGY 
We completed our analysis using 2002 United States trade data. We also examined 2003 and 
2004 data, but used 2002 data for the primary analytical tasks.3 For each of Egypt’s key 
agricultural exports, we completed the following steps: 

1. Identify all U.S. TRQs that affect key agricultural exports. Our source was a May 2005 report 
and accompanying spreadsheet prepared by the WTO Secretariat (JOB(05)/74). This 
document lists every TRQ notified by every WTO Member. Each TRQ is assigned a 
“TRQID” that corresponds to the ID number for that TRQ in each Member’s WTO 
Consolidated Tariff Schedule (CTS) file. 

In the United States’ case, some quotas are actually aggregates of other quotas. For example, 
TRQ 48 covers HS codes for cotton products that are also contained in TRQs 49-54. We 
define such aggregate quotas as “Quota Groups.” All but one of the TRQs that affects key 
Egyptian agricultural exports falls within a Quota Group. We noted the Quota IDs and Quota 
Groups for every TRQ that affects a key Egyptian agricultural export. 

2. Calculate in-quota and out-of-quota imports for each quota. This step required us to compile 
U.S. trade data for each quota by searching for and grouping together the trade data for the 
eight-digit HS codes covered by each quota. A single quota often covers a number of HS 

                                                      

3 We used 2002 data for our analysis because this is the latest year for which the United States has 
submitted (nearly) complete quota fill rate information to the WTO. By comparing our calculated fill rates 
(see below) to fill rates reported by the United States, we were able to make a valuable check on the 
accuracy of our calculations. 
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codes: for example, the table below shows the HS Codes for US TRQ 14 (butter).4 Note that 
TRQ 14 falls within a Quota Group, US TRQ 15, which also covers a number of other dairy 
products. 

HS Codes in US TRQ 14 

HS Codes – In quota HS Codes – Out-of- 
Quota 

04052020 04052030 

04059010 04059020 

21069024 21069026 

21069034 21069036 

 

One can use Microsoft Excel to sort the trade data and calculate in-quota and out-of-
quota imports, but a database program such as SAS allows for quicker calculation. We 
used SAS to sort the data. Once the data was sorted, we calculated the following for each 
quota: 

a. Fill rate.  The fill rate equals in-quota imports divided by the total quota volume. To 
verify that our calculations were correct, we compared our calculated fill rates to fill 
rates reported to the WTO by the United States.5 

b. Global Out/In Ratio. The Global Out/In Ration is the quantity of global out-of-
quota imports divided by global in-quota imports, expressed as a percentage. For 
example, a quota with an out-in ratio of 15% has out-of-quota imports equal to 15% 
of in-quota imports. 

3. Determine the binding instrument for each TRQ. We identified the binding instruments for 
each quota by using the following rules of thumb:  

Binding Instrument “Rules of Thumb” 

Binding Instrument Criteria 

In-Quota Tariff and/or Quota Administration Method Fill Rate less than 85% 

Quota volume Fill Rate >= 85% and Global Out/In Ratio <= 15% 

Out-of-quota tariff Fill Rate >= 85% and Global Out/In Ratio > 15% 

 

Strictly interpreted, the quota volume is the binding instrument only when the quota is fully filled 
and there no out-of-quota imports. We relax this definition slightly: we say that the quota volume 
is the binding instrument when the quota is mostly filled (more than 85%), and when out-of-quota 
exports are relatively small compared to in-quota imports (15% or less of in-quota imports). In 
                                                      

4 Note that the United States’ tariff schedule lists separate HS codes for out-of-quota imports, which 
makes it simple to calculate out-of-quota vs. in-quota imports. Most other countries use the same HS codes 
for in and out-of-quota imports. 

5 The WTO prepared a spreadsheet that lists Fill Rates and Quota Administration methods for Members’ 
TRQs. It is document TN/AG/S/22, June 2006. 
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other words, we count quotas that are “virtually filled” as filled, and those where out-of-quota 
imports are not significant compared to in-quota imports as being bound by the quota volumes. 

4. Determine the “negotiating priority” for each quota. We define the “negotiating priority” as 
the objective Egypt should pursue in order to expand trade under each quota. The negotiating 
We define the following options for Egypt’s negotiating priorities vis-à-vis U.S. TRQs: 

a. Expand the quota’s volume. We recommend that Egypt focus on expanding a quota’s 
volume when the quota volume is the binding instrument. 

b. Reduce in-quota tariffs AND/OR demand clearer administration methods. When quotas 
are underfilled, we recommend that Egypt focus on reductions in in-quota tariffs and/or 
greater transparency in quota administration methods. It is impossible to know which of 
these two possible barriers is the primary one – or whether some combination of both is 
at play - without deeper investigation of each case.  

c. Reduce out-of-quota tariffs: Egypt should focus on reducing out-of-quota tariffs when 
quotas are filled, yet out-of-quota imports are large in comparison to in-quota imports. In 
such circumstances, imports from Egypt are likely to increase the most from reductions in 
out-of-quota tariff rates. This recommendation assumes that one is not comparing 
enormous quota expansions with modest out-of-quota tariff cuts. 

d. Reduce out-of-quota tariffs AND/OR expand the quota’s volume. When quotas are filled 
and out-of-quota imports are important, but not overwhelming compared to in-quota 
imports, the most effective way to increase Egyptian exports is not clear without further 
investigation. Some mix of quota expansion and reduction of out-of-quota tariffs might 
maximal reduce of tariffs paid by Egypt, and therefore maximize Egyptian exports - or 
one or the other option may do so. One must examine defined liberalization scenarios to 
answer this question with precision. 
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Findings  
The findings from our analysis are presented in the SUMMARY worksheet of the TRQ Analysis 
Excel file that accompanies this report. Appendix Two to this Note is a legend that describes 
each item that appears in the SUMMARY worksheet.  

In the table below, we present a greatly abridged version of the table in Appendix Three. This 
abridged table presents information on the TRQs under which the United States actually imported 
Egyptian key agricultural exports in 2002. 6 The paragraphs below the table discuss the findings 
in more detail. 

Tariff Quotas on Egypt’s Key Agricultural Exports to the United States, 2002 

Quota ID Description 
(Abridged) 

In-Quota 

Imports 

from Egypt 

(US$) 

Out-of-

Quota 

Imports 

from 

Egypt 

(US$) 

WTO 

Reported 

Fill (%) 

Global 

Out/In 

Ratio 

(%) 

Binding 

Instrument 

Negotiating 

Priority 

USAQ016 
Cheeses and 

substitutes for 
cheese 

26,125 93,419 99 3 
Quota 

volume 
Quota 

volume 

USAQ022 

Swiss or 
Emmentaler cheese 
other than with eye 

formation, 
Gruyere-process 

cheese 

68,585 2,160 86 1 
Quota 

volume 
Quota 

volume 

USAQ051 

Cotton, staple 
length of 28.575 

mm (1-1/8 inches) 
or more but under 
34.925 mm (1-3/8 

inches) 

4,951,551 0 7 0 

In-Quota 
Tariff 
and/or 
Admin 
Method 

In-Quota 
Tariff 
and/or 
Admin 
Method 

USAQ052 

Cotton, staple 
length of 34.925 

mm (1-3/8 inches) 
or more 

13,602,844 0 13 0 In-Quota 
Tariff 

In-Quota 
Tariff 

                                                      

6 The United States did not import any key Egyptian agricultural exports under any TRQs except those 
listed here in 2002, 2003 and 2004. 
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and/or 
Admin 
Method 

and/or 
Admin 
Method 

USAQ014 Butter substitutes 0 56,169 100 12 
Quota 

volume 
Quota 

volume 

USAQ006 Dried milk 0 3,430 98 24 

Out-of-
Quota 
Tariff 

Out-of-
quota 
Tariff 
and/or 
Quota 

USAQ008 Dried milk and 
dried cream 

0 2,800 96 29 

Out-of-
Quota 
Tariff 

Out-of-
quota 
Tariff 
and/or 
Quota 

Source: WTO (Quota IDs and reported fill rates); U.S trade data (raw trade values and quantities); and author (out-of-quota 
exports, out/in ratio, and negotiating priorities) 

Long-Staple Cotton: Underfilled Quotas 
As the table above shows, Egypt’s most important agricultural export affected by TRQs is long-
staple cotton. US imports of cotton under TRQs 51 and 52 accounted for 99% of the value of key 
Egyptian agricultural exports covered by TRQs. Quotas 51 and 52 were underfilled in 2002 (and 
indeed in prior years and in 2003, as well). Because these quotas are underfilled, the binding 
instrument on both quotas is the in-quota tariff rate and/or the methods by which the quotas are 
administered. One must investigate each quota in greater detail to determine whether the tariff 
rate or the administration method is the greatest constraint. However, it is worth noting that the 
Ad-valorem equivalents for the specific tariffs that apply to the long-staple cotton quotas are quite 
low (1.49% for HS Code 52010034, which is sole product covered by Quota 51, and 0.66% for 
HS Code 52010060, which is the sole product covered by Quota 52).7 Thus, one might 
hypothesize that the administration method is the primary barrier to additional trade. 

Butter and Cheese: Quotas volumes are the binding instrument 
The cheese quotas under which the United States imports from Egypt – and the butter quota 
associated with out-of-quota imports from Egypt – were all filled in 2002. Global out-of-quota 
trade was very small for these quotas in comparison to in-quota trade. Thus, Egypt should focus 
on expansion of quota volumes for these products. 

                                                      

7 United States AVE submissions, as posted on the WTO Members’ website. 
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Dried Milk: Out-of-quota tariffs are binding, but the negotiating priority is 
not clear 
The United States’ quotas on dried milk filled in 2002. Out-of-quota imports were equal to 29% 
of in-quota imports – an important amount, but not so much that one can say without further 
investigation whether expanded quota volumes, out-of-quota tariff cuts, or some combination of 
the two will maximize Egyptian exports. 

See the SUMMARY sheet in the TRQ Analysis Excel file for data and recommended negotiating 
priorities for all other U.S. TRQs that affect key Egyptian agricultural products.  
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Next Steps 
1. Replication of this analysis for other countries. The CD/WTO can replicate this analysis for 

any country, provided that the CD/WTO has trade data disaggregated at the level used in the 
country’s TRQ schedule. For example, in the United States, the tariff lines covered by each 
TRQ are enumerated at the HS-8 level, while in India, they are enumerated at HS-6, and in 
Korea, at HS-10.  

In most countries, out-of-quota tariffs do not have separate HS numbers from in-quota tariffs. 
The simple solution for this problem is to follow the following steps for each quota: 

a. Find total imports for each tariff line covered by the quota. 

b. Find the quota volume for each quota (listed in the country’s WTO CTS database 
file). 

c. Subtract quota volume from total imports. The difference will be out-of-quota trade 
(or in the case of underfill, the gap between in-quota trade and the quota volume). 

This analytical method is complicated by some countries’ use of preferential quotas. For 
the somewhat rough analytical purposes of this exercise, one may ignore the existence of 
the preferential quotas, but one will not know the extent of out-of-quota trade that is 
entering on an MFN or preferential basis.  

The most important barrier to replication of this analysis for other countries is the limited 
availability of sufficiently disaggregated trade data. The EU makes disaggregated trade 
data available via the Eurostat website. Egypt may be able to find this data for other 
countries via the WTO Integrated Database or via TradeMap.  

2. Welfare analysis of specific liberalization scenarios. The CD/WTO may wish to commission 
a study of the likely impact of various TRQ liberalization options on Egypt. As discussed in 
the previous section, such an analysis requires significant investments of time and deep 
analytical expertise, and thus may be costly. 

3. Other “back of the envelope” analyses. In light of data limitations which may limit 
replication of this analysis and the costliness of a welfare analysis, the CD/WTO may wish to 
conduct less complicated, “back of the envelope” analyses. A few examples are suggested 
below: 

• Fill Rate Review. Fill rates for all WTO Members’ TRQs are listed in the Secretariat’s 
JOB(05)/74 report. A simple review of these fill rates will quickly yield valuable 
information: for example, a single glance at the sheet would show whether quotas Egypt 
cares about in a given market are chronically underfilled or always nearly filled.  
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• Prioritized, product-by-product analyses. Rather than try to tackle all quotas for all 
countries, the CD/WTO might choose to examine a few TRQs maintained by a few key 
trading partners. For example, if Egypt were interested in examining long-staple cotton 
quotas, it might select for analysis the top five long-staple cotton importers in the world. 
For each partner, one could compare total long-staple cotton imports to the volumes 
provided for in the partners’ quotas. One will be able to quickly get a sense in each 
country of whether imports greatly exceed quota volumes or seem to be limited by them.  

The conclusions one reaches through these methods may yield valuable information without 
great investments of time. However, results from such “quick and dirty” analyses should be 
interpreted and used with appropriate caution. 
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Appendix One: Egypt’s “Key 
Agricultural Exports” 
The products in this list are Egypt’s most important agricultural exports. We identified all U.S. 
TRQs that applied to these products. 

COTTON 520100 

RICE 100630 

VEGETABLES  

Potatoes 070190 

Onions 070310 

Dried Veg 071220 

Frozen Veg 071080 

Dried Veg 071333 

Fresh Veg Nes 070990 

Fresh Legumes 070820 

Cassava/Tubers 071420 

Tomatoes 070200 

FRUITS  

Citrus Fruits 080510 

Grapes 080610 

Fruits Other 081010 

Fruits/Nuts Proc 081110 

Dates, Figs 080410 

Melons, Papaya 080711 

FLAX 530110 



  14

OILSEEDS  

Medicine Plants 121190 

Peanuts 120210 

Seeds 120922 

Sunflower Seeds 120600 

Locust beans 121299 

Oilseeds Other 120740 

LIVE ANIMALS  

Animals Nes 010600/1 

Live Poultry 010511 

LIVE PLANTS 060220 

SUGAR/MOLASSES  

Molasses 170310 

Sugar 170111 

Confectionary 170490 

PROCESSED FRUITS/VEG 

Fruit Juice 200980 

Veg Nes 200520 

Prep Fruit/Veg 200190 

Prep Veg Nes 200410 

Jams 200799 

ANIMAL/VEGETABLE OILS 

Animal/Veg Fat 151620 

Other Veg Oils 151590 

Soybean Oil 150790 

Olive Oil 150910 

Margarine 151790 

Sunflower Seeds 151211 

DAIRY, EGGS, HONEY  

Cheese 040690 
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Eggs 040700 

Milk 040120 

Honey 040900 

Concentrated Milk 040210 

TEA, SPICES  

Tea 090240 

Seeds Anise, etc 090950 

ESSENTIAL OILS 330129 

WHEAT FLOUR 110100 

PREPARED FOODS  

Soups 210410 

Food Preps. Nes 210690 

Extracts 210120 

PREPARED LIQUIDS  

Sweetened Bev 220210 

Ethyl Alcohol 220720 

Water 220110 

BREAD 190530/1 
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Appendix Two: Legend for 
Columns in SUMMARY Table of 
TRQ Analysis.xls 
 

Name Definition Source 

Quota Group 

Aggregate quota under which the quota falls 

(if the quota is contained within a larger 

quota) 

CTS Database, TQ1 

Table 

Quota ID Tariff quota identifier 
CTS Database, TQ1 

Table 

Description Description of products covered by the quota 
CTS Database, TQ1 

Table 

Egypt In Quota Value ($) 
Value, in US$, of U.S. imports from Egypt 

within the quota in 2002 

U.S. Department of 

Commerce (DOC), sorted 

by author 

Egypt Over Quota Value ($) 

Value, in US$ of U.S. out-of-quota imports 

from Egypt of products covered by the quota 

(2002) 

U.S. Department of 

Commerce (DOC), sorted 

by author 

Egypt In Quota Quantity (kg) 

Quantity, in kilograms, of U.S. in-quota 

imports from Egypt of products covered by 

the quota (2002) 

U.S. Department of 

Commerce (DOC), sorted 

by author 

World In Quota Quantity (kg) 

Quantity, in kilograms, of U.S. in-quota 

imports from all countries of products 

covered by the quota (2002) 

U.S. Department of 

Commerce (DOC), sorted 

by author 
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Egypt Over Quota Quantity (kg) 

Quantity, in kilograms, of U.S. out-of-quota 

imports from Egypt of products covered by 

the quota (2002) 

U.S. Department of 

Commerce (DOC), sorted 

by author 

World Over Quota Quantity (kg) 

Quantity, in kilograms, of U.S. out-of-quota 

imports from the world of all products 

covered by the quota (2002) 

U.S. Department of 

Commerce (DOC), sorted 

by author 

Global Bound Quantity 

The "Quota volume" - the total quantity of  

goods covered by the quota that are 

permitted to enter the U.S. at the in-quota 

rate per annum 

CTS Database, TQ1 

Table 

Global Bound Unit 
Unit of measure for the Global Bound 

Quantity 

CTS Database, TQ1 

Table 

Calculated Global Fill Rate (%) 
World In-Quota Quantity/Global Bound 

Quantity 
Author's calculation 

WTO Reported Fill (%) 
2002 Fill Rates for each quota, reported by 

the United States  
TN/AG/S/22 

Global Out/In Ratio (%) 
World Out-of-Quota Quantity/World In-

Quota Quantiy 
Author's calculation 

Allocated Quota? 
Indicates whether the quota is allocated 

among specifically-named countries 

CTS Database, TQ3 

Table 

Egypt Specific Allocation 
Indicates whether portions of the quota are 

specifically allocated to Egypt. 

CTS Database, TQ3 

Table 

Any Country Allocation 
Indicates whether portions of the quota are 

allocated to "any country." 

CTS Database, TQ3 

Table 

Other Country Allocation 
Indicates whether portions of the quota are 

allocated to "other countries." 

CTS Database, TQ3 

Table 

Binding Instrument 

The policy measure that determines the 

domestic price and imports of goods covered 

by the quota (see Explanatory Note for 

further details) 

Author  
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Negotiating Priority 

The author's recommendation of the policy 

measures that Egypt should seek to liberalize 

(see Explanatory Note for further details) 

Author 
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Appendix Three: Step-by-Step 
Guide to TRQ Analysis 
Note: readers may wish to refer to the TRQ Analysis Excel file when reading this guide. All steps 
described below are modeled in the TRQ Analysis file. 

1. Create a new file in Excel. This will be the master document for your analysis. You can give 
it any title you like. We call it TRQ Analysis.xls. 

2. Collect the data you will need for the analysis. Download to your computer the following 
documents: 

• “Key Products” list. Appendix One contains a list of 57 agricultural products at the HS6 
level. These products account for the vast majority of Egypt’s agricultural exports.  

• JOB(05)/74 (list of all TRQs reported by WTO Members as of May 2005). You must 
use the “documents online” portal on the WTO Members-only website 
(http://members.wto.org)  to access this document. Download Part 3, which is an Excel 
file.  

• TN/AG/S/22. This document lists administration methods and fill rates for each WTO 
Member’s TRQs. The document is available on the WTO Public site. Download Part 2, 
which is an Excel file. 

• The Microsoft Access file in the WTO Consolidated Tariff Schedules (CTS) database for 
the country you are investigating.  CTS country files are available on the WTO Members-
only site. They are also available on a CD that the CD/WTO owns. There are two folders 
for each country. For example, for the USA, the two folders are “CTSUSA200m7.zip” 
and “CTSUSA200t7.zip.” Open the folder that ends in “m7.zip.” You will find a 
Microsoft Access database in the folder. Its name will be “USA00Rev7_ToExport.mdb” 
(for USA), “ECRev7_ToExport.mdb” (for the EU), etc. Copy that file to your computer. 

•   Detailed trade data for the country you are investigating. You will need trade data 
for the country you are investigating. The data should include the following: 

⎯ Coverage for at least one year. You could also compare data over several years in 
order to observe trends or exceptional changes in the data from year-to-year. 



  20

⎯ Data on both the value of trade and the quantities of trade. Be sure to note the units in 
which the trade is listed – is it actual dollars or thousands of dollars? Kilograms or 
metric tons? In the U.S. case, note that two quantities are often provided for each HS 
line. Quantity 1 is the unit of measure used for the purposes of U.S. trade statistics, 
while Quantity 2 is listed in whatever measure is used for reporting to international 
institutions. It appears that Quantity 2 is only provided when Quantity 1 is different 
from the international standard.  

Important Note 1: The data must be  disaggregated at the level of detail at which the 
country specifies tariff lines under each TRQ. For example, the United States lists the 
tariff lines under each TRQ at the eight-digit level. Thus, to do the analysis of in and 
out-of-quota trade, you need the U.S. data at the eight digit level. If you do not have 
trade data at the level of detail at which the country specifies tariff lines under its 
TRQs, you cannot determine out-of-quota imports, and you thus cannot compare out-
of-quota imports to in-quota imports.  

Important Note 2: Special note on U.S. data: detailed U.S. trade data is available 
from the U.S. International Trade Commission (USITC) at the following website: 
http://dataweb.usitc.gov. You must register for a password, but registration is free 
and anyone may request a password. You can download all the data trade you need in 
a single text (.txt) file that you may open in an Excel spreadsheet. However, sorting 
this data by quota is an extremely tedious process in Microsoft Excel.  The data may 
be sorted far more easily in the database management program SAS. [Note: We 
provided the sorted data to the CD/WTO during our consultancy.] 

3. Place the data for the analysis in the master file (“TRQ Analysis.xls”).  

• Copy and paste the Key Products. 

⎯ In the master file, create a blank worksheet and name it Key products. Copy the list 
of key products and paste it into the left-hand column of this worksheet.  

• Copy and paste data on all TRQs from JOB(05)/74.  

⎯ In the master file, create a blank worksheet and title it AllUSATRQs.  

⎯ Open JOB(05)/74.xls, then select and copy the first row, which contains the column 
headings. Paste this row into the AllUSATRQs worksheet in the master file. 

⎯ Next, select and copy all the rows that contain United States TRQs. Paste them into 
the same worksheet in the master file where you pasted the column headings. 

• Copy and paste data on administration and fill methods from TN/AG/S/22.xls. 

⎯ In the master file, create a blank worksheet and title it AllUSAdmin&Fill. 

⎯ Open TN/AG/S/22, then select and copy the first two rows, which contain the 
column headings. Paste these two rows into the AllUSAdmin&Fill worksheet in the 
master file. 
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⎯ Select and copy all the rows that list U.S. administration methods and fill rates. Paste 
these rows below the column headings in AllUSAdmin&Fill. 

• Import information on quantities and allocations from the country’s CTS database. 

 

• Create a new blank worksheet in the master file. Name it Quantities. Now go to “Data” at 
the top of the screen. In the dropdown menu, scroll over “Import External Data.” A 
second dropdown menu will appear. Click on “Import Data.” 

• A new window will appear. It is entitled “Select Data Source.” Look at the box in the 
bottom of the window entitled “Files of type.” Select any one of the following three: “All 
files,” “All data sources,” or “Access databases.”     

• Find the CTS Access database that you downloaded under Step 2 and select it.  

• A new window will appear that says “Select Table.” Choose “TQ1_Quantities.” A new 
window entitled “Import Data” will appear. Make sure that the “Existing Worksheet” dial 
is selected, click on the cell in the upper left-hand corner of the worksheet (A1), then 
click “OK.”  

• Open a new worksheet and entitle it TRQAllocation. Follow the actions as in step (iv) 
above, but select table “TQ3_OTC_Allocation.”  

⎯ Once you have imported the data into TRQAllocation, Use the AutoFilter function to 
create “Any Country” and “Other Country” subgroups below the master list of 
allocations. To use AutoFilter, highlight column H (the column that lists the countries 
to which quotas are allocated), then go to the “Data” dropdown menu and choose 
“Filter/AutoFilter.” Now use the Autofilter arrow at the top of column H to select 
“Any Country.” The list will now be filtered to show only those allocations for “Any 
Country.” Copy and paste these rows below the master list of allocations. Repeat the 
same process for “Other Countries or areas.” 

⎯ Now, assign a name to each of these two subgroups. For example, for the Any 
Country subgroup, highlight columns C through L,8 go to the “Insert” dropdown 
menu, choose “Name/Define,” type in the name “Any Country Allocate,” and select 
“OK.” Repeat this step for the Other Countries or areas rows. 

⎯ Click “Data/Filter/Show All” once you have finished creating the subgroups. 

4. Find all the TRQs that apply to the Key Products.  

• If possible, print the list of key products on the Key Products worksheet. This is not 
essential but will make the next task below go faster.  

                                                      

8 Note that if you include columns A or B in the named group, the VLOOKUP function (which you will 
use later in the exercise) does not work correctly. 
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• Go to the AllUSATRQs worksheet. Highlight Column D (the “TQ_TL” column). Go to 
the “Edit” dropdown menu and select “Find.”  A pop-up window will appear. In the 
“Find what” bar, type the first six-digit code from the key products list. Choose “Find 
all.”A list will appear that shows each occurrence of the six-digit code in the spreadsheet. 
The “cell” column indicates the cells where the code appears (“C3,” “B4,” etc.). Look at 
the number in each entry – this tells you the rows where the six-digit code appears in the 
table.9  Copy each row that contains the six-digit code, then paste it into the Key Products 
worksheet, starting in Column Three of that sheet. See the image below for an example: 

 

 

 

 

• Repeat the previous step for all the codes on the key products list.  

5. Make a list of all the quotas that affect key products. 

                                                      

9 Note that the code usually appears two times in a single row (e.g. in cells D289 and J289). This is 
because the code appears in the “TQ_TL” (Tariff Quota Tariff Line) and “” (Concession Tariff Line) 
columns.   
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• Create a new worksheet and entitle it QuotaGroups. In this worksheet, list all the 
QUOTA IDs that appear in the key products sheet (“USAQ014,” “USAQ006,” etc.).   

• Now look carefully at the Quantities worksheet. Look at the column entitled “OTC” (this 
is an abbreviation for “Other Terms and Conditions”). Create a column to the right of this 
column entitled “Aggregate Quota?” Here, you will mark an “A” next to every quota that 
is an aggregate of other quotas. Such quotas are clearly identified in the OTC column. 
See the example below:  

 

 

• Click on the letter at the top of the “Aggregate Quota” column in order to select the entire 
column. Now go to the “Data” dropdown menu, select “Filter” and then “AutoFilter.” An 
arrow will now appear at the top of the Aggregate Quota column. Filter for all columns 
marked “A.” Now, you will see a list of the quotas that group together other quotas. For 
future reference, copy into the Quota Groups sheet the ID of each aggregate quota and 
the OTC cell that names all the quotas that are aggregated within that quota. For example, 
you would copy: 

USAQ048 Aggregate for USAQ049, USAQ050, 
USAQ051, USAQ052, USAQ053, USAQ054 
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And so forth.  

 

6. Make a list of all the IN QUOTA tariff lines covered by the TRQs that affect key 
products.  

• Label the columns in the Quota Groups worksheet as follows: 

 

Aggregate Quota TRQID IN/OV HS 

 

• Now, Find the first quota listed on the “Quota Groups” worksheet that is not an aggregate 
quota. Return to the “AllUSTRQs” sheet. For that quota, list in the “Quota Groups” 
worksheet all the in-quota lines (listed in the “TQ_TL” column).  Then, look at your 
reference list of aggregate quotas, and see if the quota is covered by an aggregate quota – 
for example, the TRQ identified as USAQ030 falls under USAQ031. List the tariff lines 
as follows:  

 

Aggregate Quota TRQID IN/OV HS 

GROUP 31 USAQ030 IN 17019154 

GROUP 31 USAQ030 IN 17049074 

GROUP 31 USAQ030 IN 18062075 

GROUP 31 USAQ030 IN 18062095 

GROUP 31 USAQ030 IN 18069055 

GROUP 31 USAQ030 IN 19019056 

GROUP 31 USAQ030 IN 21011254 

GROUP 31 USAQ030 IN 21012054 

GROUP 31 USAQ030 IN 21069078 

GROUP 31 USAQ030 IN 21069095 
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• The HS column lists each HS code in the quota.  

• In/Ov indicates whether the HS line is in-quota or over-quota.  

• TRQID tells the name of the quota. 

• Aggregate Quota tells the name of the aggregate quota, if any, under which the quota 
falls. To avoid confusion, you might name the aggregate quotas “Groups” (for example, 
you might call TRQ031, which is an aggregate quota, “Group 31”). Note that some 
quotas do not fall within larger, aggregate quotas, so the “Aggregate quota” column will 
be blank for all HS lines in the non-aggregated quotas.  

• Complete the steps above for all the quotas listed on the “quota groups” page, so that you 
have a list that looks like this:  

 

7. Make a list of all the OVER QUOTA tariff lines associated with the TRQs that affect 
key products.  

• Each HS line covered by the TRQs has an associated over quota tariff line. For quotas 
that are not aggregate quotas, the column “TL” lists the over quota HS line associated 
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with each Quota and each In-quota HS Line.10 For example, the column TL lists the over 
quota HS code for this product… 

 

 TQ_TL       TL  

USAQ016 Cheeses and 
substitutes for 
cheese (except 
(i) cheese not 
containing cow's 
milk; (ii) soft 
ripened cow's 
milk cheese; (iii) 
cheese (except 
cottage cheese) 
containing 0.5 
percent or less 
by weight of 
butterfat; and, 
(iv) articles 
within the scope 
of other 

04069095    -------
Described 
in 
additional 
U.S. note 
16 to this 
chapter 
and 
entered 
pursuant 
to its 
provisions.

10   2000 04069097    

… but NOT for the same product when listed for TRQ015, which is the aggregate quota that 
contains USAQ016: 

 

 TQ_TL       TL  

USAQ015 Cheese 04069095    -------
Described 
in 
additional 
U.S. note 
16 to this 
chapter 
and 

10   2000 04069095

                                                      

10 Note that this is true for the U.S., but not for all countries. For example, many countries use the same 
HS code to record in-quota and over-quota trade. You must consult the tariff schedules and Uruguay Round 
commitments of each country to see how they structure in-quota tariffs vs. over-quota tariffs. 
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entered 
pursuant 
to its 
provisions.

 

• Now, follow the steps listed in Step 6 above, but for OVER QUOTA tariffs. You can list 
these quotas directly under the in-quota tariffs, as follows: 

 

GROUP 5 USAQ004 OV 04013075 

GROUP 5 USAQ004 OV 04039078 

GROUP 5 USAQ004 OV 04051020 

GROUP 7 USAQ006 OV 04021050 

GROUP 7 USAQ006 OV 04022125 

GROUP 7 USAQ008 OV 04022150 

GROUP 7 USAQ008 OV 04039055 

GROUP 5 USAQ009 OV 04022190 

GROUP 5 USAQ009 OV 04039065 

 USAQ010 OV 04022950 

 USAQ010 OV 04029990 

 USAQ010 OV 04031050 

 USAQ010 OV 04039095 

 

Note: Your list of out-of-quota lines should contain exactly the same number of over-quota lines 
as in-quota lines, as there is an over-quota line corresponding to each in-quota line.  

8. Sort the trade data by quota in order to determine in and out-of-quota trade for each 
quota.  You will need to create a new worksheet where you will organize the trade data.  
Title it “InOverTrade.” You will sort it to show the following: 
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a) In-quota Imports from Egypt under each quota. 
b) In-quota Imports from the World under each quota.  
c) Out-of--quota Imports from Egypt for each quota. 
d) Out-of-quota Imports from the World for each quota. 
 
You will want to calculate (a)-(d) for all the “regular” quotas (quotas that are not aggregates, 
or “Groups” of other quotas) that affect key products. If possible, you should also complete 
the analysis for all of the aggregate quotas (or “Quota Groups”). We found that it is was 
difficult to calculate in and over-quota imports for the group quotas due to differences in 
quantity units within the groups. But it should be possible to do so.  

 

NOTE: As indicated in Step (2) above, you can download detailed U.S. trade data at the 
following website: http://dataweb.usitc.gov. This data may be sorted in Excel. [NOTE: to 
expedite the exercise, we provided the data, sorted in SAS, to the CD/WTO staff]  

9. Use AutoFilter to organize the data according to each of the four subgroups described 
above.  

• The data we provided you looked like this: 
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Use the AutoFilter function to organize it into the subgroups named in step (8) above. To use 
AutoFilter, highlight columns C and D, then go to the “Data” dropdown menu and choose 
“Filter/AutoFilter.” Now use the AutoFilter arrows at the top of column C and D to select the 
subgroups. Copy and paste each autofiltered group below the master list of data in InOverTrade, 
and type the name of each subgroup above each subgroup, as illustrated below:  

  

• Now, assign a name to each subgroup. For example, for the World In Quota group, 
highlight the cell in columns B through J11, go to the “Insert” dropdown menu, choose 
“Name/Define,” type in the name “World In Quota,” and select “OK.” Repeat this step 
for all of the groups, using the appropriate name for each group. 

 
10. Create a table to summarize important lessons from the data.  You will certainly have 

observed that your Excel file contains many worksheets! You will now create a final, single 
worksheet where you will perform your most important analysis and present your results. 
Entitle this worksheet SUMMARY.  

• You will want to label the columns in the Summary table using the labels listed in the 
table below.  

                                                      

11 You should omit column A – including it in the subgroups causes problems for VLOOKUP. 
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Label What the Column Contains How to get the data 

Quota ID 
Group 

The names of the Quota Groups under 
which “regular” quotas in your table are 
grouped (if applicable). 

Copy and Paste from the InOverTrade worksheet 

Quota ID The TRQ ID for each “regular” quota in 
your table 

Copy and Paste from the InOverTrade worksheet 

Description description of each TRQ  VLOOKUP from the Quantities worksheet 

Egypt In Quota 
Value ($) 

Value, in US$ of U.S. imports from 
Egypt within the quota in 2002 
 

VLOOKUP from the “Egypt In Quota” subgroup in InOverTrade 

Egypt Out-of-
Quota Value ($) 

Value, in US$ of U.S. out-of-quota 
imports from Egypt in 2002 

VLOOKUP from the “Egypt-Out-of-Quota” subgroup in 
InOverTrade 

Egypt In Quota 
Quantity (kg) 

Quantity of In-quota imports from Egypt 
for each quota 

VLOOKUP from the “Egypt In Quota” subgroup in InOverTrade  

World In Quota 
Quantity (kg) 

In-quota imports from the World for 
each quota 

VLOOKUP from the “World In Quota” subgroup in InOverTrade 

Egypt Out-of-
Quota Quantity 
(kg) 

Out-of-quota imports from Egypt for 
each quota 

VLOOKUP from the “Egypt Out-of-Quota” subgroup in 
InOverTrade  

World Out-of-
Quota Quantity 
(kg) 

Over-quota imports from the World for 
each quota 

VLOOKUP from the “World Out-of-Quota” subgroup in  
InOverTrade  

Global Bound 
Quantity 

Total bound quantity for each quota VLOOKUP from the Quantities worksheet 

Global Bound 
Unit  

The total bound quantity for each quota VLOOKUP from the Quantities worksheet 

Calculated 
Global Fill Rate 
 

World In Quota Quantity/Global Bound 
Quantity 

Calculate using an Excel division formula 

Global Out/In 
Ratio (%) 

World Out-of-Quota Quantity/World In 
Quota Quantity 

Calculate using an Excel division formula 

WTO Reported 
Fill 

The fill rates for each quota as reported 
by the countries and listed in 
TN/AG/S/22 

VLOOKUP from AllUSAdmin&Fill 

Allocated 
Quota? 

Indicates whether each quota is allocated 
by country. 

IF/VLOOKUP from the TRQ Allocation (see special instructions 
below).  

Egypt Specific 
Allocation 
 

Indicates whether each quota is allocated 
by country 

Use AutoFilter to search for Egypt in the “partner” column of  
TRQAllocations (Note that Egypt also appears as “Egypt & 
Sudan”). Type “Yes” or “No” in the “Allocation for Egypt” 
column to indicate whether the quota has a specific allocation for 
Egypt. 

Any Country 
Allocation 

Indicates whether each quota includes an 
allocation to “Any Country” 

VLOOKUP from the “Any Country Allocate” subgroup in 
TRQAllocation. 

Other Country 
Allocation 

Indicates whether each quota includes an 
allocation to “Other Countries or Areas” 

VLOOKUP from the “Other Country Allocate” subgroup in the 
TRQAllocation. 

Binding 
Instrument 
 

The policy measure that determines the 
domestic price and imports of goods 
covered by the quota (see Explanatory 
Note for further details) 
 

IF logical statement that specifies the parameters of each binding 
instrument (see the formula in the “Binding Instrument” column 
of the SUMMARY spreadsheet in the TRQAnalysis Excel file). 
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Negotiating 
Priority 

The policy measures that Egypt should 
seek to liberalize (see Explanatory Note 
for further details) 

IF command that specifies the criteria for each negotiating 
priority  (see the formula in the “Negotiating Priority” column of 
the SUMMARY spreadsheet in the TRQAnalysis Excel file) 

 

• Special VLOOKUP instructions for the AllocatedQuota? column: 

⎯ Open the worksheet entitled TRQ Allocation. To the right of the column entitled 
“Aggregate Quota?” create a column entitled “Allocated by Country?”  

⎯  Now, look at the “OTC” column. Each time that you see the words “See TQ3,” you 
know that the quota is allocated by country, because “TQ3” is the table in the CTS 
database that lists allocations by country (it is the “TRQAllocations” table in your 
Excel file). 

⎯ In the “Allocated by Country?” file, place a “1” in each row where “See TQ3” 
appears in the OTC column. The “1” identifies those quotas that are allocated by 
country.  

⎯ Select columns C through P of the “Quantities” table, and name this group of cells 
“Quantities.” 

⎯ Return to the summary sheet. In the “Allocated Quota?” column, you will use an 
IF/VLOOKUP formula that follows this format:  

=IF(VLOOKUP(B3,Quantities,14,FALSE)=0, “No”, “Yes”) 

Use this command for each row in the Summary Table. “Yes” will appear for each 
quota that is allocated by country, and “No” will appear for non-allocated quotas.  
 

11. Add in lines for the Quota Groups.    

• It is important to show in your table all of the Quota Groups that affect the “regular” 
(non-aggregate) quotas in your table. As mentioned above, it is somewhat complicated to 
calculate the in- and over-quota trade for the group quotas. However, you can easily use 
VLOOKUP to fill in the following columns for the Aggregate Quotas: 

⎯ Description 

⎯ Global Bound Quantity 

⎯ Global Bound Unit 

⎯ WTO Reported Fill 

⎯ Allocated Quota? 

⎯ Allocation for Egypt? 

  

 




